Foreword

The African Virtual University (AVU) is proud to participate in increasing access to education in African countries through the production of quality learning materials. We are also proud to contribute to global knowledge as our Open Educational Resources (OERs) are mostly accessed from outside the African continent. This module was prepared in collaboration with twenty one (21) African partner institutions which participated in the AVU Multinational Project I and II.

From 2005 to 2011, an ICT-integrated Teacher Education Program, funded by the African Development Bank, was developed and offered by 12 universities drawn from 10 countries which worked collaboratively to design, develop, and deliver their own Open Distance and e-Learning (ODeL) programs for teachers in Biology, Chemistry, Physics, Math, ICTs for teachers, and Teacher Education Professional Development. Four Bachelors of Education in mathematics and sciences were developed and peer-reviewed by African Subject Matter Experts (SMEs) from the participating institutions. A total of 73 modules were developed and translated to ensure availability in English, French and Portuguese making it a total of 219 modules. These modules have also been made available as Open Educational Resources (OER) on oer.avu.org, and have since then been accessed over 2 million times.

In 2012 a second phase of this project was launched to build on the existing teacher education modules, learning from the lessons of the existing teacher education program, reviewing the existing modules and creating new ones. This exercise was completed in 2017.

On behalf of the African Virtual University and our patron, our partner institutions, the African Development Bank, I invite you to use this module in your institution, for your own education, to share it as widely as possible, and to participate actively in the AVU communities of practice of your interest. We are committed to be on the frontline of developing and sharing open educational resources.

The African Virtual University (AVU) is a Pan African Intergovernmental Organization established by charter with the mandate of significantly increasing access to quality higher education and training through the innovative use of information communication technologies. A Charter, establishing the AVU as an Intergovernmental Organization, has been signed so far by nineteen (19) African Governments - Kenya, Senegal, Mauritania, Mali, Cote d’Ivoire, Tanzania, Mozambique, Democratic Republic of Congo, Benin, Ghana, Republic of Guinea, Burkina Faso, Niger, South Sudan, Sudan, The Gambia, Guinea-Bissau, Ethiopia and Cape Verde.

The following institutions participated in the teacher education program of the Multinational Project I: University of Nairobi – Kenya, Kyambogo University – Uganda, Open University of Tanzania, University of Zambia, University of Zimbabwe – Zimbabwe, Jimma University – Ethiopia, Amoud University - Somalia; Université Cheikh Anta Diop (UCAD)-Senegal, Université d’ Antananarivo – Madagascar, Universidade Pedagogica – Mozambique, East African University - Somalia, and University of Hargeisa - Somalia
The following institutions participated in the teacher education program of the Multinational Project II: University of Juba (UOJ) - South Sudan, University of The Gambia (UTG), University of Port Harcourt (UNIPORT) – Nigeria, Open University of Sudan (OUS) – Sudan, University of Education Winneba (UEW) – Ghana, University of Cape Verde (UniCV) – Cape Verde, Institut des Sciences (IDS) – Burkina Faso, Ecole Normale Supérieure (ENSUP) - Mali, Université Abdou Moumouni (UAM) - Niger, Institut Supérieur Pédagogique de la Gombe (ISPG) – Democratic Republic of Congo and Escola Normal Superieur Tchicote – Guinea Bissau

Bakary Diallo

The Rector

African Virtual University
Production Credits

This second edition is the result of the revision of the first edition of this module. The informations provided below, at the exception of the name of the author of the first edition, refer to the second edition.

Author
Elijah I. Omwenga

Reviewers
Esther Fomsi
Hernani Chantre

AVU - Academic Coordination
Dr. Marilena Cabral

Module Coordinator
Hernani Chantre

Instructional Designers
Elizabeth Mbasu
Diana Tuel
Benta Ochola

Media Team
Sidney McGregor          Michal Abigael Koyier
Barry Savala             Mercy Tabi Ojwang
Edwin Kiprono            Josiah Mutsogu
Kelvin Muriithi          Kefa Murimi
Victor Oluoch Otieno     Gerisson Mulongo
Copyright Notice

This document is published under the conditions of the Creative Commons
http://en.wikipedia.org/wiki/Creative_Commons

Attribution http://creativecommons.org/licenses/by/2.5/

Module Template is copyright  African Virtual University  licensed under a Creative Commons
Attribution-ShareAlike 4.0 International License. CC-BY, SA

Supported By

AVU Multinational Project II funded by the African Development Bank.
Table of Contents

Foreword 2
Production Credits 4
Copyright Notice 5
Supported By 5
Introduction 6
  Prerequisite Course or Knowledge .............................................. 6
  Time .................................................................................. 7
  Materials ............................................................................... 7
  Module Rationale .................................................................... 8
  Content .................................................................................. 9
    Overview ........................................................................... 9
    Outline ............................................................................... 9
    Graphic Organizer ............................................................... 10
  Objectives ............................................................................... 10
    General objective(s) ............................................................... 10
    Specific learning objectives .................................................. 10
Teaching and Learning Activities 12
  Pre-assessment ...................................................................... 12
    Answer Key ......................................................................... 14
  Pedagogical Comment For Learners. ........................................ 16
Appendices 17
  Key Concepts (Glossary) ......................................................... 17
  Compulsory Readings .............................................................. 19
  Compulsory Resources ............................................................ 20
  Useful links. .......................................................................... 20
Learning Activities 24
  Activity 1: Introduction to the Graphic Tools. ......................... 24
  Key concepts .......................................................................... 24
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to the learning activity</td>
<td>25</td>
</tr>
<tr>
<td>Detailed description of the learning activity</td>
<td>25</td>
</tr>
<tr>
<td><strong>Activity 2: Digital Resources for teaching science and mathematics with 3D objects expectations</strong></td>
<td></td>
</tr>
<tr>
<td>D objects expectations</td>
<td>30</td>
</tr>
<tr>
<td>Summary of the learning activity</td>
<td>30</td>
</tr>
<tr>
<td>List of relevant readings (for the activity)</td>
<td>31</td>
</tr>
<tr>
<td>Key Concepts</td>
<td>31</td>
</tr>
<tr>
<td>Learning Activity</td>
<td>32</td>
</tr>
<tr>
<td><strong>Activity 3: Digital resources for teaching and learning with multiple objects expectations</strong></td>
<td></td>
</tr>
<tr>
<td>objects expectations</td>
<td>33</td>
</tr>
<tr>
<td>Summary of the learning activity</td>
<td>33</td>
</tr>
<tr>
<td>Key concepts</td>
<td>33</td>
</tr>
<tr>
<td>Introduction to the learning activity</td>
<td>34</td>
</tr>
<tr>
<td><strong>Activity 4: Simple Web Page design expectations</strong></td>
<td></td>
</tr>
<tr>
<td>Key concepts</td>
<td>36</td>
</tr>
<tr>
<td><strong>Synthesis of the Module</strong></td>
<td>44</td>
</tr>
<tr>
<td><strong>Summative Evaluation</strong></td>
<td>45</td>
</tr>
<tr>
<td>Assessment</td>
<td>49</td>
</tr>
<tr>
<td><strong>References</strong></td>
<td>50</td>
</tr>
<tr>
<td><strong>Student Records</strong></td>
<td>51</td>
</tr>
<tr>
<td><strong>Main Author of the Module</strong></td>
<td>52</td>
</tr>
</tbody>
</table>
Introduction

Computers and information technology have changed the world and affected millions of lives in ways that no one could have foreseen. There is a general agreement that computer technology is a crucial resource in education today. Computers and ICT can bring benefits such as: use of productivity tools; interactive teaching packages available on CD for different subjects; access to internet and thousands of online databases; distance learning facilities; links to other schools or colleges; and special facilities available for students with disabilities—for example partially-sighted students may be able to change text sizes and background colour. The list is long.

This module picks on some of these benefits and provides a basic platform to multi-media applications in the teaching and learning of mathematics and Science at secondary school level.

Prerequisite Course or Knowledge

Before embarking on this module, you should have covered the following modules:

Module Specific knowledge or skills

<table>
<thead>
<tr>
<th>Module 1</th>
<th>Keyboarding and computing skills;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to ICT</td>
<td>Introduction to ICT acquaintance with computer input and output devices; basic knowledge of learning management systems (LMS); computer network and communication tools; basic internet skills.</td>
</tr>
<tr>
<td>Module 2 Text based productivity tools</td>
<td>Knowledge of Windows operating system; Word processing skills; Desktop publishing skills.</td>
</tr>
<tr>
<td>Module 3 Graphics and Information management systems</td>
<td>Knowledge and applications of: Spreadsheets software; database software; and presentation software.</td>
</tr>
</tbody>
</table>
Time

The total time is 120 hours apportioned as follows:

<table>
<thead>
<tr>
<th>Activity Unit</th>
<th>Activity Unit</th>
<th>Unit</th>
<th>Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learning activity 1</td>
<td></td>
<td>one</td>
<td>30</td>
</tr>
<tr>
<td>Introduction to graphic tools</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Learning activity 2</td>
<td></td>
<td>two</td>
<td>30</td>
</tr>
<tr>
<td>Digital resources for teaching and learning with 3D objects</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Learning activity 3</td>
<td></td>
<td>three</td>
<td>30</td>
</tr>
<tr>
<td>Digital resources for teaching and learning with multiple objects</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Learning activity 4</td>
<td></td>
<td>four</td>
<td>30</td>
</tr>
<tr>
<td>Simple Web-page design</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Materials

The following table provides basic hardware and software needed for the course delivery. Other materials not mentioned in the table such as printed manuals, printed notes, and so forth, may also be considered.
## Module Rationale

Multimedia is the combination of several elements such as text, graphics, animation, video and sound using a computer, to create an interesting but well informed teaching and learning materials. To create or run multimedia software, a fairly powerful computer with a large memory, hard disk and a CD Rom drive is desirable.

You will have to make an informed choice of the multimedia elements to incorporate in your teaching and learning process. This will largely depend on where you are situated and the extent to which multimedia facilities are available to or accessible by you. Where sophisticated facilities and software are not available, it is advised here that the learning process can still be made lively and effective by use of ordinary colours. For example in a Biology class, before a student begins to use a Microscope, they should know the functions of different parts of the microscope. Paint brush can be used with a combination of other tools to colour and label the different parts of a microscope for the learners. The picture can be saved in MS PowerPoint and displayed to students during a Biology lesson. It can also be printed on paper and displayed in the classroom notice board for the learners.
Multimedia applications are important because they can make learning interesting. It is therefore important that simple multimedia clips are integrated into the teaching and learning of Mathematics and Science where appropriate. For this to be achieved basic ICT skills and proficiency are expected or indeed assumed of you. This being the fourth module in the series of ICT Basics Skills, your ability to go through it will depend on your proficiency in the first three modules.

Content

Overview

This module contains four units which are conveniently structured into four respective learning activities. Unit one deals with Introduction to graphic tools. Unit two discusses digital resources for teaching and learning science and mathematics with emphasis on 3D objects. Unit three introduces digital resources for teaching & learning with emphasis on multiple objects. Unit four discusses the basic principles and tools for web page design.

Outline

Unit 1: 30 hours
Introduction to graphic tools
Use of basic tools to design, or use appropriate in-built pictures for teaching & learning mathematics and science.

Unit 2: 30 hours
Digital resources for teaching &
learning mathematics and science. with 3D objects

Unit 3: 30 hours
Digital resources for teaching & learning mathematics and science. with multiple objects

Unit 4: 30 hours
Web page design
Basic skills for creating a web page. Using the skills in the context of mathematics and science teaching and learning.
Graphic Organizer

Objectives

General objective(s)

1. Capture, edit, design and integrate objects into a teaching document using graphics software.
2. Integrate audio, video and other clips into a teaching document
3. Identify available Internet applet resources for use in subject documents
4. Integrate the various productivity tools and multimedia components in the compilation of Science and Mathematics teaching and training tools and materials.

Specific learning objectives

/Instructional objectives

Unit 1

Introduction to graphic tools (30 hrs)
Introduction

Objectives

By the end of this unit, you should be able to:

1. Create graphics by painting or drawing
2. Bring graphics into the application from a digital camera or scanner
3. Edit and save graphics in a required form

Unit 2
Digital resources for teaching and Learning with 3D objects (30hrs)

Objectives

Upon completion of this unit, you should be able to:

1. Use a collection of 3D objects and instructional materials for mathematics and science
2. Develop additional 3D instructional materials for use in the classroom.

Unit 3
Digital resources for teaching and Learning with multiple objects
(30hours)

Objectives

Upon completion of this unit, you should be able to:

1. Use a collection of multiple objects and instructional materials for mathematics and science teaching and learning

Unit 4
Simple Web page Design (30 hours)

Objectives

Upon completion of this unit, you should be able to:

1. Design a simple Web page using Word template or a wizard
2. Insert, edit, and format content from a variety of sources
3. Insert Hyperlinks
4. Preview a website in authorizing software and in a browser
Teaching and Learning Activities

Pre-assessment

Title of Pre-assessment: Introduction to Multimedia design and Applications

Rationale

The pre-assessment is intended to ascertain the level of familiarity of the learner with basic multimedia concepts. You will find that many of the questions do not ask for a specific correct answer, rather, they are meant to test your current knowledge so that appropriate learning activities can be designed. Put (X) against the answer of your choice in each question. At the end of questions you will find the answers. You are advised to check the answers after writing down all your answers.

Questions

1. What do you understand by the word Graphics?
   a. Information conveyed through sound only
   b. Information conveyed through a combination of diagrams, pictures and text.
   c. Information conveyed through text messages only

2. What is meant by “teaching and learning Mathematics and Science using Multimedia”
   a. To use any combination of pictures, sound, movements, texts etc in teaching and learning
   b. To teach many students seated together in one classroom without writing on the blackboard.
   c. I don’t know what this means.

From Q3-Q7, indicate your experience with the following pieces of equipment:

3. Digital camera
   a. I have seen it but not used it.
   b. I have used it
   c. No experience at all

4. Video camera
   a. I have seen it but not used it.
   b. I have used it
   c. No experience at all
Teaching and Learning Activities

5. Desk top computer
   a. I have seen it but not used it.
   b. I have used it
   c. No experience at all

6. Scanner
   a. I have seen it but not used it.
   b. I have used it
   c. No experience at all

7. Printer
   a. I have seen it but not used it.
   b. I have used it
   c. No experience at all

From Questions 7-10, indicate your experience with the following services

8. E-mail
   a. I have used it
   b. I know about it but have not used it
   c. No experience at all

9. World Wide Web (www)
   a. I have used it
   b. I know about it but have not used it
   c. No experience at all

10. Internet
    a. I have used it
    b. I know about it but have not used it
    c. No experience at all

11. Searching for information from the internet
    a. I have done it
    b. I know about it but have not practically done it
    c. No experience at all
12. Saving useful information from the internet onto my storage device (diskette, flash disk).
   a. I have done it
   b. I know about it but have not done it practically
   c. No experience at all

From Questions 12-15, choose one response that applies to you.

13. There is a lot of information out there on the Internet which one could get for teaching and learning mathematics and science.
   a. TRUE
   b. FALSE
   c. I don’t know

14. Today’s technology makes it possible to take a picture of a Physics Practical experiment taking place in one school, save the pictures on a computer and send them to another school by email.
   a. TRUE
   b. FALSE
   c. I don’t know

15. Even if my school does not have the internet connection, I can still access information downloaded from the Internet provided I have a computer with necessary storage devices.
   a. TRUE
   b. FALSE
   c. I don’t know

Answer Key

1. Refer to Module 3

A picture is worth a thousand words. This is an over-used phrase but its truth has remained. Graphics add personality to your presentations and often convey information more efficiently than text alone. Elements of graphics in a document include clipart, pictures, graphs and charts.

2. To use any combination of pictures, sound, movements texts etc in teaching and learning, Mathematics and Science. The aim is make the learning of abstract ideas and concepts relatively simple to follow and also interesting to learn.
3. Used to ascertain level of knowledge and experience at entry

The ideal assumption is that you have used the equipment. However if you have not used the equipment or even seen it, that means your score in this question is 0 (zero). This does not mean that you have failed the question but it is used only to gauge your entry point. Please proceed to the next Question.

4. Used to ascertain level of knowledge and experience at entry Please proceed to the next Question.

5. Used to ascertain level of knowledge and experience at entry Please proceed to the next Question

6. Used to ascertain level of knowledge and experience at entry Please proceed to the next Question.

7. Used to ascertain level of knowledge and experience at entry Please proceed to the next Question.

8. Used to ascertain level of knowledge and experience at entry Please proceed to the next Question.

9. Used to ascertain level of knowledge and experience at entry Please proceed to the next Question.

10. Used to ascertain level of knowledge and experience at entry Please proceed to the next Question.

11. Used to ascertain level of knowledge and experience at entry Please proceed to the next Question.

12. Used to ascertain level of knowledge and experience at entry

Please proceed to the next Question.

13. The statement is true. The Internet is basically a network of computers located at different servers around the world, and able to communicate with each other via satellite. In this regard it makes it possible to access information from a given source once the address of that particular source is known.

14. The statement is true. Today’s technology makes it possible for example to take a picture of a Physics Practical experiment or indeed any science activity taking place in a school, save the pictures on a computer and send them to another school by email. You can take a picture of a Science activity (e.g. a practical experiment taking place in a laboratory) using a digital Camera. The Camera is connected to a computer and the pictures saved. If the computer has an email facility, the pictures may be sent (e-mailed) to a computer in another school, as an email attachment. Some text can be included with the pictures to describe the experiment.
The statement is true. Storage devices are those component of a computer system that hold data and programs for current and future use. It is possible to access digital information which have been (saved) stored as files on CD-ROM, USB drive or any other storage device. To access such information, you need a computer installed with appropriate software in which to open the files. For example, you may need MS Office, Adobe Reader, and so on, depending on the original source of data.

**Pedagogical Comment For Learners**

You have just gone through the pre-assessment exercise to test your current knowledge of graphic and multimedia elements to be studied in detail later in this module. Your honest response to the questions is key if you are to gain maximum benefit from this module. Each question carries one point, so the maximum points in this pre-assessment is 15. You are to total up all the points that you have gained from the pre-assessment and respond according to the guidelines given below. The key concepts used in the Pre-assessment will be discussed in Section 10. (KEY CONCEPTS.-GLOSSARY). Please read the key concepts together with the previous ICT Basic Modules you have been referred to. If you have scored the maximum possible points in this Pre-assessment, go through the key concepts in Section 10 and proceed to the Learning activities:

<table>
<thead>
<tr>
<th>Score</th>
<th>Action to take</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 points</td>
<td>Proceed straight to learning activity 1</td>
</tr>
<tr>
<td>Between 10-15 points</td>
<td>Proceed to learning activity 1 after reading through the key concepts and trying the failed questions.</td>
</tr>
<tr>
<td>Between 8-10 points</td>
<td>Go through one module from modules 1, 2, and 3 and try the failed questions again.</td>
</tr>
<tr>
<td>Between 5-8 points</td>
<td>Go through two modules from modules 1, 2, 3 and try the failed questions again.</td>
</tr>
<tr>
<td>Below 5</td>
<td>Go through all modules 1, 2, and 3 and try the questions again. Proceed to learning activity #1 if the score is above 10.</td>
</tr>
</tbody>
</table>
Key Concepts (Glossary)

**E-mail** - Email stands for electronic mail. Basically it is similar to sending a letter to another person. The only difference here is that instead of using the surface mail, we use a computer to send the message.

**E-mail Attachment** - This is usually a separate document sent by email. The main reason for sending a document as an attachment is to make it easy to receive as one coherent piece of document.

**Graphics** - A combination of diagrams, pictures or graphs used to express ideas in a simple form and also to make the presentation lively and interesting.

**Information** - Data that has been selected, organized, and made appropriate for a particular use.

**Multimedia** - Any combination of text, graphics, sound, and video that is programmed into and delivered by the computer.

**Desktop Computer** - Computers primarily designed for single users, hence their alternative name of personal computer (PC) systems.

**Scanner** - A device that converts photographs, drawings, forms, texts or any combination of these into a digital form.

**Printer** - A type of hard copy output device used to create text or graphic image on paper.

**Autoshapes** - An object from the drawing toolbar which allows you complete control over every aspect of that object.

**Browser** - An application that allows you to find and view information on the world wide web. Major browsers include Netscape Navigator and Microsoft Internet Explorer.

**Clip Art** - A pre-created, usually copyright-free, graphic image that can be inserted into a document to illustrate a point or to add visual interest. Clip art often comes in large collections.

**Drawing Toolbar** - Contains tools and buttons used for creating and formatting text, boxes, shapes, lines, and WordArt.
**HTML:** An acronym for Hyper Text Mark up Language, which is the Office XP applications can automatically convert the formatting you have given a document into HTML, which functionally turns their files into Web pages.

**Hyperlink:** Text or graphics that, when clicked, takes you directly to a predefined location within a document or to a specific page on the World Wide Web.

**Web Discussion:** A feature that enables users to attach comments to a web page or a document that can be opened with a web browser.

**Web Page:** A computer file including text, data, and or graphics that users may access on the World Wide Web portion of the internet.

**WWW (World Wide Web).** A major component of the Internet which is a vast global network of smaller networks and personal computers utilizing internet communication protocols. WWW pages generally include text, graphics, hyperlinks; advanced WWW can include sounds, digital movies, and similar features.

**Wizard:** A series of specialized dialog boxes that walks you through the completion of certain tasks. When you use a wizard to create a document, you are asked a series of questions about document preferences, and then the wizard creates the document to meet your specifications.

**Server:** A server is a computer which provides information or resources (for example file servers) on the Internet.

**Template:** A pre-designed document, worksheet, presentation slide, or database, with a given basic structure, that you can fill with your own text, data or graphics.
Compulsory Readings

Reading 1


http://oooauthors.org/en/authors/userguide2/published

Abstract: This book provides the reading you need on using graphic tools. Chapter one introduces the toolbars. Chapter two discusses how to draw basic shapes such as a line, a circle, ellipse, etc. Chapters three and four deal with editing objects. Chapter five is about managing 3D objects and bitmaps. Chapter six is about combining multiple objects. Chapter seven provides useful tips and tools for editing objects. This book is on CD for you.

Rationale: The book provides material on how to create and edit graphics in an easy to follow format. It contains good illustrations and guidance to the user to practice with the computer.

Reading 2


http://oooauthors.org/en/authors/userguide2/published

Abstract: This book not only provides material relevant to this module but also helps the learner to revise material covered in the previous modules. The topics and chapters directly linked to this module include menus and toolbars (chapter 4), getting started with draw (chapter 8), creating presentation (chapter 9), working with templates (chapter 12), working with gallery (chapter 14), and creating web pages (chapter 16). This book is on CD for you.

Rationale: The book provides comprehensive information in basic ICT as an open source. It has good illustrations for the reader and provides reading tips. Its coverage of web page design makes it an appropriate text for this module.

Reading 3


http://oooauthors.org/en/authors/userguide2/published

Abstract: This is a concise presentation guide which shows the learner how to create a graphic presentation, to format a presentation, choosing the layout, inserting new slides, and running the slide show. This book is on CD for you.
Rationale: The presentation guide shows the learner in a practical way how to create and run a graphic presentation. Its clarity makes it a must read for every student of basic ICT.

**Compulsory Resources**

**Resource 1**


Abstract: This page provides a wide range of free educational clip art from the web. A teacher of science and mathematics will find relevant images and graphics for teaching and learning.

Rationale: The choice of this page has been motivated by its immense potential to provide a pool of teaching and learning resources for Science and mathematics learning.

**Resource 2: Clip Art-Math and Science**


Abstract: This page contains specific images for teaching and learning mathematics and science at secondary school. All the science subjects namely Biology, Chemistry, and Physics have images associated with their teaching and learning. For example, a microscope is used in the Biology experiments, the solar system is a domain of physics, while the use of electronic calculator is in mathematics and statistics. There are many images to choose from in any of the subjects mentioned depending on the topic of the lesson in progress.

Rationale: The link has useful pictures for teaching and learning concepts in mathematics and science. The pictures can also be freely used for educational purposes. They can for instance be downloaded in a computer and viewed on a Power Point during an on-going lesson.

**Useful links**

**Useful Link 1**


Screen capture:
Appendices

Description: These pages provide useful exposition on for example, the subject of mathematics, citing the historical developments of mathematics. The branches of mathematics such as Pure, Applied are discussed in detail.

Rationale: The site provides useful links in the broad areas of Mathematics and Science. The contents of are well researched and grounded
Useful Link 2

Screen capture:

Description: This site has a collection of teaching and learning resources for Mathematics and Science.

This site contains links to assist educators in finding online web graphics to enhance their webs. Before taking any images always make sure they are in the public domain. Some sites may require that you place a link on your page in return for using the images.

Rationale: The site contains links which will assist educators in finding web graphics that will enhance their work. Some images are free but some require that you place a link in return. Please read carefully.

Useful Link 3: Graphics:

URL:

Description: The page provides a free range of graphics (some animated) for use in classroom demonstrations. Some of these graphics are relevant in Mathematics, and Science.

Rationale: The pages provide free animated graphics which are useful in demonstrating mathematics and science concepts to the learners.
Useful link 4

Title: Animated Educational Clip art

URL: http://www.teacherfiles.com/clip_animated.htm

Description: This collection has been geared specifically to the needs of teachers. The collection is a free animated educational clip art which can be put on for the learners.

Rationale: This pages provide good teaching resource for Mathematics and Science which a teacher can make use of.

Useful link 5: Multimedia teaching tools

Description: The site has many sources of multimedia teaching tools which a teacher can make use of. For example, assessment tools webpage hosting tools, planning tools and a host of classroom projects. Specific examples are Math Resources and Teachers, compiled by Sue LeBeau, from miscellaneous free tools to templates for the classroom to web page building.

Rationale: The reference provides a wide range of multimedia and graphics resources for the teacher to choose from for his/her use in the teaching and learning of science and Mathematics.

Useful link 6: Web resources for students

URL: http://www.2lean.ca

Abstract: This site has links to a wide range of learning resources and ICT activities for students. For example, some of the useful information include resources on how to use the internet, how to use web browsers, how to search the web, how to evaluate web resources, and how to cite web resources. The link for these activities can be accessed at http://www.2lean.ca/mapset/new2net/webways.html

Rationale: The site provides useful links to learning resources and tools for students to engage in a range of activities.
Learning Activities

Activity 1: Introduction to the Graphic Tools

expectations

By the end of this unit, you should be able to:

1. Create graphics by painting or drawing
2. Bring graphics into the application from a digital camera or scanner
3. Edit and save graphics in a required form

Summary of the learning activity

In this section you will:

1. Identify multimedia tools from the AutoShapes menu
2. Identify basic drawing tools available in MS Word
3. Access the different drawing tools from the drop down menus
4. Use the tools correctly
5. Search for learning resources on graphics from the Internet
6. Use presentation tools

Key concepts

**AutoShapes**: in-built drawings and shapes in the computer which you can copy and use in your own drawings.

**Drawing tools**: these are in-built resources in the computer used for creating drawings.

**Graphics**: Pictures, drawings, photographs, illustrations intended to clarify certain concepts.

**Presentation**: the act of sharing the content of a given topic, prepared by you, with an audience.
Learning Activities

List of relevant readings (for the activity)

List of relevant resources (for the activity)
Computer lab, computers, fax machine, LCD projector, PowerPoint presentation software, printer.

List of relevant useful links
Modules 1, 2 and 3 in ICT Basic Skills

Introduction to the learning activity
A large variety of teaching and learning materials in science and mathematics can be illustrated by different graphic representations, for example, line graphs, bar charts or pie charts and AutoShapes. Familiarity with the ways graphics are used will help you present your work clearly in many subject areas and in your work. In teaching and learning, graphics, however simple they may be, will help you to clarify ideas and concepts to your learners. In the past teachers had to labour and do most of the drawings they needed for their lessons manually. Today much of that labour has been reduced by use of ICTs. There are many drawings in-built in the computer which a teacher can borrow and use freely in his lessons. A lot of the drawings are found in the AutoShapes Sub-menu.

In the activities that follow, you will learn how to use drawing tools in the computer. You will also identify and use a number of in-built drawings in the computer for teaching and learning purposes.

Detailed description of the learning activity
You can display AutoShapes in the Print Layout and Web Layout views only, where Word offers several categories of AutoShapes, including Lines, Basic Shapes, Block Arrows, Colours, Stars and Banners.
To put an AutoShape picture in your Word document for example, you do the following:

1. Put the cursor where you want the picture to be in your document
2. Click on AutoShapes submenu
3. Select one of the sub-menus under AutoShapes
4. From the Submenu move the cursor to the particular picture
5. Double click the mouse
6. The picture is copied to the place where you want it to be.

There are more pictures given in the Autoshapes menu. To view the pictures do the following:

1. From the Auto shapes menu
2. Press M on the key board or move the cursor to the More AutoShapes submenu and click on it.
3. A number of pictures will show on the right side of your screen.
4. Double click on the picture you want and it will be copied to your document.
Learning Activities

example 1

Below are some examples of the pictures copied from the Autoshapes menu into this document. To identify each of the pictures:

1. Go to the Autoshapes menu where they are found
2. Put the cursor on the picture
3. The name of the picture automatically pops out.

![Autoshapes](image)

*Fig. Different pictures of multimedia equipment obtained from AutoShapes*

example 2:

Learning activity: Use of Drawing tools and colours to show direction to a rural secondary school

In this learning activity, drawing tools have been used to create a roadmap to a rural secondary school from the nearest town. The names used in this drawing are for illustration purposes and should not be interpreted literally as such.

*Fig. Smiley*
Explanation of the Drawing:

The road map was created using drawing tools from the Autoshares toolbar. The arrows are obtained from block arrows submenu of the Autoshares. Other shapes are obtained from square or circle respectively on the toolbar. The different colours are also obtained from the fill colour and line colour on the toolbar.

The above drawing can be saved in PowerPoint and presented to an audience. For example, a student may present it to School management for approval as the official roadmap for the school.

The drawing can be saved in PowerPoint in many ways. The simplest way is to highlight the document, copy it from the edit menu, open the Power Point window and paste the document again from the edit menu. Then you can adjust the document to make it fit well into the power point window.

Learning activities


Draw Guide.OpenOffice.org: Authors, pp.1-54, before you embark on these exercises.

(b) Individual work: Using the appropriate drawing tools, draw the following shapes and fill in the colours shown in bracket.
Learning Activities

(i) Triangle (brown)
(ii) Rectangle (blue)
(iii) Square (yellow)
(iv) Circle (green)
(v) Ellipse (orange)

Group project

Discuss in a small group of 5 members how you to use the drawing tools studied in the compulsory reading to work on the following project:

You are to use a computer to design a model senior Secondary School. Include the following facilities in your drawing:

- Classroom block(s)
- Science Laboratory
- Computer Laboratory
- Play grounds (Netball, football, Volleyball, Tennis)
- Church, Mosque
- Head teacher’s Office
- Staff room
- Staff houses

Save the document in a PowerPoint ready for presentation to a school audience.

Formative evaluation

1. Click on the AutoShapes toolbar. From the More Auto Shapes menu, identify and correctly name any six multimedia tools found in that menu.

State the application of each tool in the teaching and learning of Mathematics and Science.

2. The learning objects applicable in this evaluation on Mathematics and Science are obtainable via internet link from http://www.teacherfiles.com/clip_math.htm.

Categorize the objects according to their direct application in Mathematics and Science. Try to name some of the mathematical and science objects.
3. Select and name five AutoShapes each from the following categories
   (i) Basic shapes
   (ii) Block Arrows
   (iii) Stars and Banners
   (iv) Flow Chart
   (v) Connectors

4. Optional: (Formative assessment for self reflection):
   (a) Outline the difficulties you encountered when carrying out this assignment.
   (b) What approach would you use to teach this topic to secondary school students for them to appreciate and actively participate in the learning process.
   (c) How would you evaluate the success or otherwise of your lessons in

**Activity 2: Digital Resources for teaching science and mathematics with 3D objects expectations**

By the end of this module the student should be able to:

- Use a collection of 3D objects and instructional materials for mathematics and science;
- Develop additional 3D instructional materials for use in the classroom

**Summary of the learning activity**

Three dimensional (3D) drawings make learning of mathematics and science less abstract for the learners. In this activity you will create 3D objects relevant to the teaching and learning of mathematics and science, and add different features on them.
Key Concepts

3D Objects: Objects which can be represented into three dimensions as opposed to two dimensions

Extrusion Operation: Process of converting a 2D drawing into a 3D object.

3D-Effects: Attributes associated with 3D objects.

Scaled Depth: Defines the dimension ratio between the front face and the back face of an object.

Rotation Angle: Angle which a given shape is rotated about an axis.

Horizontal & Vertical Segments: Define the number of segments for rounded shapes. The higher the number, the smoother the surface will be.

Shading: This is linked to the shading of objects

Shading mode: Refers to the method by which objects are made to interact with light.

Shadow: This allows you to display shadows under 3D objects

Illumination: Defines the way in which 3D objects are illuminated from a light source.

Material Management: Material concerns the use of materials on the surface of 3D objects. This is used to give an object the appearance of commonly used materials such as plastic, or metal.

List of relevant readings (for the activity)

List of relevant resources (for the activity)

Computer with connection to the internet, CD-Rom loaded with compulsory reading notes. List of relevant useful links: [http://oooauthors.org/en/authors/user-guide2/published](http://oooauthors.org/en/authors/user-guide2/published) Introduction to the learning activity: The learning activity described below is centred on managing 3D objects. The importance of 3D objects in mathematics and science is primarily to make teaching and learning mathematics and science less abstract to the students. Creation and manipulation of the 3D objects to promote learning is therefore central in this activity.

Detailed description of the learning activity

Three dimensional (3D) geometric objects are useful in the learning of mathematics and science in that they make the learning of concepts less abstract. For example in physics shapes like cube, cone, and cylinder make it easier when teaching the concepts of volumes and surface area of different geometric shapes. Another aspect where 3D objects are very helpful in mathematics and science is when you want to determine an angle between two planes. Without a sketch some students will find it hard to imagine the position of the planes. Similarly, 3D objects are also applicable in chemistry for illustrating the chemical bonding of atoms. In this case, atoms are represented by spherical drawings or objects which are arranged accordingly.

In this learning activity you are to use a computer software to create 3D objects of different shapes and sizes. You are to rotate the objects about the x, y, and z planes respectively.

3D effects:

The 3D effects are a range of attributes associated with 3D objects. For example you can draw a circle and modify it to a three dimensional object. You can also use a geometry page to define geometric settings that are linked to 3D objects. When you change a 2D figure (e.g. a square) into a 3D figure, (e.g. rectangular box) by extrusion, you can round the edges of the box using the Rounded edges parameter. The higher the percentage of roundedness the smoother the edges of the 3D object.

Other attributes associated with managing 3D objects include scaled depth, rotation angle, horizontal and vertical segments, shading, shading mode, shadow, illumination, and material management.

Learning Activity


Practical (Group work): Draw a square and use the extrusion operation to convert the 2D drawing into a rectangular box. Round the edges of the rectangular box with 30% rounding. Using shading mode to make the object appear very smooth.

Formative evaluation: Draw a circle and use the extrusion operation to convert it into a sphere. Use the material management page to give the sphere an appearance of gold.
Activity 3: Digital resources for teaching and learning with multiple objects expectations

By the end of this module you should be able to:

- Use a collection of multiple objects and materials for teaching and learning mathematics and science.

Summary of the learning activity

This learning activity builds on learning activity 2 where you concentrated on 3D objects. In this learning activity you will learn two distinct ways of forming multiple objects. These are grouping and combining. Under grouping you will learn to group objects by common selection, how to maintain and undo groups, and how to nest groups. Under combining groups you will learn how to merge, subtract or intersect shapes. You will also learn how to create complex shapes. There are many practical examples for you to work on.

Key concepts

- **Multiple objects**: A combination of two or more drawings or objects.
- **Grouping**: Putting objects together and applying global changes to them
- **Nested groups**: Nested groups are groups of groups.
- **Merging objects**: This is the union of the objects
- **Subtracting objects**: This is the processes of removing one object from the other.
- **Intersecting shapes**: This is when two objects are made to occupy an area

List of relevant readings (for the activity)


List of relevant resources (for the activity)

Computer with connection to the internet, CD-Rom loaded with compulsory reading notes.

List of relevant useful links

http://oooauthors.org/en/authors/userguide2/published
Introduction to the learning activity

In this learning activity two distinct ways of forming multiple objects are discussed. The two major methods of forming multiple objects are grouping and combination. Under these methods a number of subtopics are discussed. These include grouping by common selection, maintenance of groups, undoing of groups, nesting of groups, merging, subtracting, and intersection of shapes respectively. Since this is a practical activity, a lot of work is to be done through practical examples on the computer.

Detailed description of the learning activity

In learning activity #2, we learnt that drawings or learning objects play a vital role in the teaching and learning of mathematics and science. One key role highlighted is that they make abstract concepts in mathematics and science easier to learn and appreciate.

Because of the nature of science and mathematics in general, it is not possible to rely on one set of objects or drawings. In many instances there is need to combine a number of drawings to form the desired shape. The different shapes or drawings in the combination is referred to here as the multiple objects. Some of these objects are inbuilt and can be obtained from the computer whereas some can be drawn on the computer by the user.

Grouping and Combining

Using draw, you can combine drawing objects in two distinct ways: grouping and combining.

Grouping

Grouping is like putting objects in a container. You can move them up in group and apply global changes to them. A group can always be undone and the objects that make up the group can be manipulated separately.

Combination

A combination is a permanent fusion of objects leading to a new object.

In a combination, the original objects do not retain their individual identity and the operation once carried out cannot be reversed.

Grouping by common selection

When you select a number of objects, any operation you carry out will apply to all the selected objects. For example you can move the entire group to the left or to the right of your screen. As soon as you click outside the common selection, the group is undone. However you can group objects and keep the selected objects together in their group.

Maintenance and Undoing of groups

To group selected objects, right-click the mouse and choose Group from the context menu. You can also use the keyboard short cut Control + Shift + G or choose Modify > Ungroup from the menu bar. See Belzunce, et al (2006, page 76).

You can create “nested” groups or “groups of groups”. If you ungroup a group, you are left with individual groups.
Merging, Subtracting, Intersection of shapes

The functions Merge, Subtract, and Intersect can be reached through a group’s context menu, under the heading Shapes.

Merging

When you merge objects the new object covers the entire space of the original objects (it is the union of objects)

Learning activities

2. Practical Using a computer, go step by step through the practical examples (1)-(7) page 79-80.
3. Group work

Go through exercises on pages 80-8 in groups of four students.

Activity 4: Simple Web Page design expectations

By the end of this unit, you should be able to:

1. Design a simple Web page using Word template or a wizard;
2. Insert, edit, and format content from a variety of sources;
3. Insert Hyperlinks;
4. Preview a website in authoring software and in a browser;

Summary of the learning activity

In this module you will

- Design a Web page using Word template or a wizard;
- Insert, edit, and format content from a variety of sources;
- Insert Hyperlinks in a text document;
- Preview a website in authorizing software and in a browser;
Key concepts

**Browser**: An application software that allows you to find and view information on the World Wide WEB (WWW). Major browsers include Netscape Navigator and Microsoft Internet Explorer.

**Hyperlink**: Text or graphics that, when clicked, takes you directly to a prede- fined location within a document or to a specific page on the World Wide Web.

**Internet**: A network of computers located at different servers around the world, and able to communicate with each other via satellite.

**Intranet**: A private network that is contained within an organization or an enterprise.

**Template**: A pre-constructed document e.g. worksheet, presentation slide having already a basic structure that you can fill to create your document.

**Web page**: A computer file including text, data, and or / graphics that users may access on the WORLD WIDE WEB portion of the internet.

**Website**: A collection of web pages providing information on an individual, an institution or organization. For example, the AVU website is www.AVU.org

**Word**: Software such as Microsoft Word used to create documents.

Introduction to the activity

Web pages serve a variety of functions. The design of a page should complement its purpose. For example a page that is intended to provide information will generally be text oriented, without graphics and animations. The graphics can be distracting and they take longer to load, both of which would interfere with the goal of the page. Word provides a number of Web page templates that allow you to focus on the content of the page without having to worry about its lay out.

In this activity you will design simple web pages to give you confidence in using already designed pages. While the design of a web page is not the key activity in Basic ICT skills, it is nevertheless important to introduce you to the basic skills at this stage. As your knowledge and dexterity advance, you can then become an expert in Web design. But it requires more study and practice with time.
More insight on this can be found on [http://www.teacherfiles.com/website_introduction.htm](http://www.teacherfiles.com/website_introduction.htm).

**Detailed description of the activity**

Word 2002 allows you to convert any of your documents into web pages by simply using a File’s menu Save as Web Page command. This command translates your document into HTML (Hyper Text Mark-up Language), the standard programming language used to write web pages. The formatting and functionality of your original Word document will be carried over to the Web page.

**Activity**

You can save a Word document, Excel Workbook or PowerPoint presentation as a Web page. This allows you to place information on the internet or on your University or College intranet. When saving information as a Web page, you specify a filename and title for the page. The filename is the name you use to store the page on your computer.

The title is the text that appears at the top of the Web browser window when a reader views your page.

**Saving a Word document as a web page**

To be able to carry out this activity you should have created the word document you want to save as a Web page.

Then go through the following steps:

1. Open the document you want to save as a Web page
2. Click file
3. Click Save As Web page
4. Type the filename for the Web page
5. Click Change Title
6. Type the title of the Web page
7. Click OK

**example**

As an example of the application, use the above steps to save the following information as a Web page

“…ICT is of such importance to the future industrial and commercial health of a country that investment in the equipment, teacher education, and support services necessary for the delivery of an ICT-based curriculum should rank high in any set of Government priorities”. (UNESCO, 2002, p.12).
Procedure

1. Type the document in word Use the spell check from the Tools menu to make sure that the spellings are correct.

2. From File menu, save the document with the name “Importance of ICT”

3. Follow through Step 2 up to 7 as outlined above. You should get the output as shown below.

Once you have a file stored as HTML it can be published on the Web by uploading it to a web server. Anyone with an Internet connection and a web browser will then be able to view your Word documents.

Many of the word documents can benefit from the inclusion of graphics. Word provides a number of methods for inserting different types of images. For example you can add Clip art drawing from the Microsoft Clip Art gallery or you may draw your own figures using tools available on MS Word drawing toolbar.

Activity ii: Creating a Web page from an existing Microsoft Word document

1. On the File menu, click New.

2. In the New Document task pane, click From existing document.

3. Select the document that you want to base your Web page on, and then click Create New.
Activity iii:

In this lesson you will learn how to create a Web page using a Template: TEMPLATE. A pre-designed document, worksheet, presentation slide, or database, with a given basic structure, that you can fill with your own text, data or graphics.

1. On the File menu, click New.

2. In the New Document task pane, under Other templates, click on My computer.

3. On the Web Pages tab, double-click the template that you want to base your Web page on.
Activity IV: Creating Hyperlinks within text

HYPERLINK: An hyperlink is text or graphics that, when clicked, takes you directly to a predefined location within a document or to a specific page on the World Wide Web.
1. Select the text or picture you want to display as the hyperlink, and then click Insert Hyperlink on the Standard toolbar or on the Insert Menu bar.

2. Do one of the following

Link to an existing file or Web page

1. Under Link to, click Existing File or Web Page

2. In the Address box, type the address you want to link to or, in the Look in box, click the down arrow, and navigate to and select the file.

3. Click OK or Enter on the keyboard.

Hyperlinks are important on web pages because they decongest the page. Only information relevant to that page is provided on the page. Additional information is provided through hyperlinks. For instance in learning activity #1 you designed and presented a Roadmap to a Rural Secondary School.

You can add textual information to the drawing to form one document. Using the procedure outlined above, the document can put on the School web page.

Below is the entire document before it is saved as a web page.

**OMORO PUBLIC SECONDARY SCHOOL**

School Profile1

Name: Omoro Public Secondary School

Status: Public School Licensed by Ministry of Education (Both "O" and "A" level)

Current student enrolment: 750 (500 girls, 250 boys)

Maximum Capacity: 850 Students

Head teacher: Ms. Joan Adong, BEd, Dip Admin. Deputy Head teacher: Mr. Peter Chihaka

Location: 70 km East of Lira, at Omoro Township Staff: 20 (13 women, 7 men)
Fig. Showing the School profile and Road map to Omoro Public Secondary School

1. Then names used in this document are purely for purposes of illustration and bear no linkage at all to any individuals or institutions.

Fig. Preview of the Web page for Omoro Public School
Learning activities:

1. Reading:


2. Group work

(a) The Headmistress of Omoro Public Secondary School would like to put more information about the school on Website www.schoollprofile.edu. The information include

(i) Names of all teachers and their academic qualifications

(ii) Summary statistics of the previous year’s performance at O-Level examinations in terms of how many students (female, male) passed in divisions 1, 2, 3 and 4 respectively.

(b) Design and typeset this information as a word document. Create hyperlinks on surnames of the teachers and on summary statistics of school performance.

(c) Save the document as a Web page on the website www.schoollprofile.edu

3. (Optional)

Describe the importance of creating a web page for your school. What changes would you expect after putting your school on the internet. Justify your answer (250 words max).

Formative evaluation:

1. Explain the meaning of the following words: Web page, Template, Hyperlinks, Browser, Website, Intranet, Internet

2. What purpose do the hyperlinks serve on a Web page.

3. Differentiate between a Web page and a Web site.

4. What is a Web server and what function does it serve?
Synthesis of the Module

This module is made up of four units. Unit one discussed graphic tools and their applications. Various graphics are created using drawing tools built in the computer. Unit two discussed the digital resources for teaching and learning mathematics and science with three-dimensional (3D) objects. The key point about using 3D objects is to make the learning of science and mathematics less abstract. In unit three the discussion centred on digital resources for teaching and learning with multiple objects. Here the creation of complex objects representing different real objects are made possible. The forth unit focuses on simple web page designs. The design of a web page is intended to facilitate sharing of information among schools via the internet.
Summative Evaluation

Instructions

This evaluation comprises twenty questions. In each question, choose the most correct answer from the options provided.”

1. To add, delete, or modify text or drawing to a file is known as:
   A. opening
   B. closing
   C. booting
   D. editing

2. Which of the following words is meant by “Pixel”.
   A. Picture excellent
   B. Picture extraction
   C. Picture element
   D. PowerPoint in Excel

In Questions 3-4, name the multimedia equipment.

3. 
   A. Toner
   B. Scanner
   C. Camera
   D. Printer
4.

A. Digital projector
B. Digital camera
C. Digital video projector
D. Digital video camera

5. In a given document, text that is underlined and colour blue is most likely:
A. Word art
B. An hypertext
C. Selected text
D. A placeholder

From questions 6-13 select only ONE best answer for each question. The possible answers are labelled A-H.

<table>
<thead>
<tr>
<th>Statement</th>
<th>Possible answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>6. Creates an HTML document</td>
<td>A. Draw menu</td>
</tr>
<tr>
<td>7. Pictures included with word that you can insert in a document</td>
<td>B. Web page preview</td>
</tr>
<tr>
<td>8. Found on the picture tool bar</td>
<td>C. Insert picture dialog box</td>
</tr>
<tr>
<td>9. A category of AutoShapes</td>
<td>D. Save as Web Page</td>
</tr>
<tr>
<td>10. Contains the Order command</td>
<td>E. Stars and banners</td>
</tr>
<tr>
<td>11. Allows you to place graphics you have on file in a document</td>
<td>F. Hyperlink</td>
</tr>
<tr>
<td>12. Text that you can click to connect to another target, document or file</td>
<td>G. Clip Art</td>
</tr>
<tr>
<td>13. Allows you to view a document as it will appear on the web</td>
<td>H. More Brightness button</td>
</tr>
</tbody>
</table>
14. If you want to make changes to a web page that you are viewing in your Browser, you click the browser’s
   A. Home button
   B. Back button
   C. Refresh button
   D. Edit button

15. To change the text used in WordArt, you need to access the:
   A. WordArt Gallery
   B. Edit WordArt dialogue box
   C. Microsoft Clip Gallery
   D. Style Gallery

16. The texture tab can be found in the:
   A. Fill effects dialog box
   B. Word Art Gallery
   C. Auto shape dialog box
   D. Insert hyperlink dialog box

17. The Auto shapes toolbar is found on the:
   A. Picture toolbar
   B. Formatting toolbar
   C. Refresh button
   D. Edit button

In Questions 18-20, state whether the following statements are TRUE (T) or FALSE (F)

18. You can use a combination of software and hardware to play, view, and edit a wide variety of multimedia. (T/F)

19. You cannot use your computer to listen to music and view photos, drawings, videos, and animations (T/F)

20. A digital image is any picture that exists in an electron format. (T/F)
Answer keys
1. D
2. A
3. D
4. D
5. B
6. D
7. G
8. A
9. E
10. H
11. C
12. F
13. B
14. D
15. A
16. A
17. A
18. T
19. F
20. T
Summative Evaluation

Assessment

For you to pass this module, you have to obtain at least 10 points overall, distributed fairly among the units.

The overall grading of the module is as below:

<table>
<thead>
<tr>
<th>Points</th>
<th>Remark</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>18-20</td>
<td>Excellent</td>
<td>A</td>
</tr>
<tr>
<td>15-17</td>
<td>Very Good</td>
<td>B+</td>
</tr>
<tr>
<td>12-14</td>
<td>Good</td>
<td>B</td>
</tr>
<tr>
<td>10-11</td>
<td>Pass</td>
<td>C</td>
</tr>
</tbody>
</table>

---------------------------------------

| 8-9    | D          |
| 5-7    | E Below 5  | F     |

---------------------------------------

PASS mark for the module is 10 points. Below 10 you are to repeat the module.
References

- UNESCO (2002). Information and Communication Technology in Education: A Curriculum for Schools and Programme of Teacher Development. UNESCO.
Name of the EXCEL file: Student Assessment Record

<table>
<thead>
<tr>
<th>Student name</th>
<th>Registration number</th>
<th>Assessment 1</th>
<th>Assessment 2</th>
<th>Assessment 3</th>
<th>Assessment 4</th>
<th>Total Grade</th>
<th>Final Remark</th>
</tr>
</thead>
</table>

Note: Specific assessment formats are left to the AVU partner Institutions.
Main Author of the Module

MR. GEORGE L. EKOL, BSc, MSc. E-mail: glekol@utlonline.co.ug

ekol@math.mak.ac.ug

George Ekol is a lecturer and acting head of Mathematics Department in Kyambogo University, Kampala, Uganda. He holds a Masters degree in Mathematics (Mathematical statistics) from Makerere University, Uganda. His research interest includes statistical modeling, statistical computing and mathematics education.

Mr. Ekol is a member of national and international professional associations, including Uganda Mathematical Society (UMS), American Statistical Association (ASA), International Statistical Institute (ISI), and International Association of Statistical computing (IASC) among others. He has presented academic papers in both national and international mathematics education conferences. He is the author of “Differential Equations” for the African Virtual University (AVU) Open Distance e-Learning (OD